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1 Introduction to Cloud Security Connectors for Netskope.
The Cloud Security Connector (CSC) is a device that enables easy deployments of the Netskope 

SASE solution in any customer environment. 

The CSC's GRE Cluster lets you connect securely to Netskope NewEdge up to 1 Gbps without 

hassle.

The primary purpose of the CSC GRE family is simplicity: You don't need to re-architect your 

network. The CSC GRE is a direct replacement for your current Web Security Appliance. You can 

place the CSC GRE on the same network segment that your existing appliance and the CSC will 

redirect the traffic to Netskope NewEdge.

No configuration is required. Simply filling a form with your IP addressing, download the CSC (VM) 

and power it on.

The CSC GRE comes with all parameters to work with Netskope NewEdge. As soon you lunch the 

CSC at the location, the CSC will automatically connect to the best Netskope NewEdge nodes. The 

CSC GRE contains the perfect configuration for GRE tunnels, firewall rules and routing tables that 

are necessary.

You can run the CSC GRE on any virtual software: Vmware, Hyper-V, KVM, Etc, and a hardware 

version is also available on request.

All Netskope NewEdge functionalities are available. Internal IPs are completely visible on the 

Netskope NewEdge GUI.

Includes Private Cloud Private Access functionality that allows you to create a full mesh among the 

CSCs communicating your private traffic on a Zero Trust model.

Simple to install with complete management from Amazon AWS, Rundeck (or similar, like Ansible, 

Salt, Etc.) and SSH.

2 Key benefits of the Cloud Security Connector GRE
• No Networking knowledge is required. 

• The CSC is a direct replacement for your current legacy Web Security Appliance.

• With Private Cloud Private Access you can connect all sites securely on a Zero Trust model. 

The CSC secures your Private Traffic between your locations.

• Enables any Location to be connected to Netskope NewEdge up to 1 Gbps.

• Easy to create: Filling a form indicating your IPs and GWs. 
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• Easy to deploy: Deploy OVA file setting the External and the Internal interface. 

• The CSC comes with the optimal values to work with Netskope NewEdge and the best 

Nodes selected for your public IP. 

• Full tunnel redundancy.

• High Availability. 

• All traffic steering options supported:

◦ Route all traffic to Netskope (or http/s only).

◦ Use of PAC files.

◦ Use of Explicit Proxy.

◦ No default Route scenarios.

• Multiple options to Bypass Traffic:

◦ Layer 7 Proxy Bypass to Trusted Web Sites.

◦ Layer 4 Routed Bypass: TCP, UDP and ICMP per source/destination Network and Port 

(UDP/TCP)

• Cloud Firewall and Cloud Web Security.

• Complete visibility of internal IPs on Netskope Console. 

• No operational burden for Administrators.

• Full hardened device.

• Works behind a NAT

• All virtual platforms supported: Vmware, Hyper-V, KVM, Etc. Hardware version available if 

required.

• Multiple tools for testing and troubleshooting included: Speed Test, MTR (MyTraceRoute), 

Keepalives statuses, Etc. 

• Allow the internal communication between your locations with Private Cloud Private 

Access.

• Management via SSH, AWS Systems Manager, Rundeck or similar. (Ansible, Salt, Etc.)

• Small OVA instance: 2 CPU, 4 GB RAM, 16 GB Disk
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3 Network Diagrams

3.1 Before (using Legacy SWG) and After (using CSC + Netskope)

    BEFORE

          AFTER 
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3.2 Information required to create the CSC
The following network diagram shows the information required to create the CSC GRE Cluster:
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3.3 Example of Proxied Traffic to Netskope: ON/OFF Corporate Network. 
This example shows how a User will have the same connectivity experience ON Corporate Network and OFF Corporate Network (at home, for 

example) thanks to the combination of the CSC + Netskope Web Security and Private Access. 
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3.4 Example of Routed Traffic to Netskope: ON/OFF Corporate Network. 
This example shows how a User will have the same connectivity experience ON Corporate Network and OFF Corporate Network (at home, for 

example) thanks to the combination of the CSC + Netskope Web Security and Private Access. 
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3.5 Steering: Routing and Proxying all together.
The most significant benefit of the Cloud Security Connector for Netskope is that it covers all possible scenarios (routed traffic, PAC files, explicit 

proxy, Etc.) for any device on your organization: Laptops, Desktops, Servers, IoT devices, Etc.

The following picture shows the CSC working will all scenarios combined. 
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3.6 Private Cloud Private Access (PriCPA)
With the CSCs for Netskope, you can create your Private Cloud for connecting all your internal devices in a Zero Trust model from your physical and 

cloud locations.
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4 Creating the Cloud Security Connector.
The creation of the CSC GRE Cluster is straightforward. Your only task is filling a form and to adding 

your Public IP on the Netskope console.

4.1 Network Diagram - IP addressing.

4.2 Adding your Public IP to the Netskope console
On your Netskope Console go to: Settings -> Security Cloud Platform -> (Traffic Steering) GRE and 

click "NEW GRE CONFIGURATION"
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1. Put a Name for the GRE configuration in "Configuration Name"

2. Put your Public IP in "Source Peer"

3. Save.

You new configuration will appear on the GRE Menu.

4.3 Filling the Form.
Before you start, you need to have this values ready:

a) Five consecutive IPs for the internal interface of the CSC and its gateway IP. 

b) Four consecutive IPs for the external interface of the CSC and its gateway IP.

c) (optional) DNS servers Primary and Secondary.

d) (optional) Syslog/SIEM servers Primary and Secondary.

e) The Public IP to be used for the GRE tunnels. 

f) (optional) Public SSH key/s for remote access to the CSC. 

g) (optional) Proxy Bypass: URL to PAC file.

h) (optional) Routed Bypass: URL to JSON file.  

The Form is at this URL: https://bit.ly/2YG7SPm

Please, follow the instructions on the Form. 

4.4 What's next?
You will receive an email with the link to the URLs to download the OVA files of the Cloud Security 

Connectors. 
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5 Firewall Requirements
The CSC GRE Cluster uses four IPs on the external interface, and it is required to set up specific NAT
and Allow Rules in your Firewall for all of them.

The following table shows the name and purpose of each one. 

External IP# Name Purpose

First GRE Tunnel IP Source IP of the GRE Tunnel

Second Bypass Egress IP Source IP of the Routed, Proxied Bypasses and Private Access.

Third  CSC IP(eth0) -a External IP of the VM -a

Fourth  CSC IP(eth0) -b External IP of the VM -b

 

5.1 NAT requirements
External IP# Name NAT Type required: via Public IP

First GRE Tunnel IP STATIC (also called 1:1 NAT) 1 The GRE Public IP configured on the Netskope 
Console.

Second Bypass Egress IP STATIC2 or DYNAMIC.  Any Public IP - This will be your "Source Public 
IP"3 when reaching Trusted Sites and connecting 
other Locations when using Private Access. 

Third  CSC IP(eth0) -a DYNAMIC (also called 1:N  NAT) Any Public IP

Fourth  CSC IP(eth0) -b DYNAMIC (also called 1:N  NAT) Any Public IP

5.1.1 Checkpoint Firewall example

The images below shows the NAT on a Checkpoint Firewall. 

1 Some firewall may require a dedicated IP when the protocol is GRE.
2 When using Private Access, it is required to use Static Nat to avoid changing the packet's Source Port.
3 Be sure that you are Natting the  "Bypass Egress IP" via the Public IP configured on your "Trusted sites". 
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5.2 Allow Rules required

5.2.1 Outbound Rules:

The following table shows the allow rules required.

External IP# Name Protocol Ports / Service Destination

First GRE Tunnel IP GRE (47) None.(4) Netskope Nodes

Second Bypass Egress IP TCP, UDP or ICMP 1 to 65535 (5) Internet, Trusted Destinations, Private 
Access Nodes. 

Third  CSC IP(eth0) -a 
 CSC IP(eth0) -b

PING icmp_echo Netskope Nodes and FW Gateway (6)

Fourth TCP 80, 443 AWS Systems Manager (7), Others (8)

5.2.2 Inbound Rules:

External IP# Name Protocol Ports / Service Source

First GRE Tunnel IP

Second Bypass Egress IP UDP Any (default 51820) Private Access Nodes. 

Third  CSC IP(eth0) -a 
 CSC IP(eth0) -b

Fourth

5.2.3 Checkpoint Firewall Example

4 GRE is protocol and has not ports.
5 You can create rules on your FW enabling only what is on the bypass list or to allow "Bypass Egress IP" for all 

protocols and ports to any destination. Private Access traffic (UDP) will use this interface inbound and outbound. 
6 The CSC GRE Cluster pings the Gateway IP of the Firewall to check reachability. 
7 When using AWS SSM Agent, allow HTTPS from the csc-external-a (-b) to AWS. The AWS destinations are: 

ssm.<AWS region>.amazonaws.com, ec2messages.<AWS region>.amazonaws.com
8 The CSC retrieves the Proxy PAC URL, Routed JSON URL and the Private Access JSON URL via csc-external-a (-b). If 

you are hosting this URLs externally, please, create a rule to allow the CSC to reach them. 
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6 Installing the OVA or Disk file in your Virtual Platform.
The following examples shows the installation on Vmware and Hyper-V. 

6.1 Using VMware 5.x
1. Go to vSphere, File > Deploy OVF template

2. Select the OVA File:

3. OVF Template Details: Click Next

4. Name and Location: Put the Name you want.

5. Resource Pool: Place the VM where you want.

6. Disk Format: Click Next

7. Network Mapping: Please map the interfaces EXTERNAL and INTERNAL to your interfaces.  

Here an example:

8. Click "Next"

9. Click "Finish"
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6.2 Using VMware 6.x
1. Go to Virtual Machines → Create/Register VM

2. Deploy a virtual machine from an OVF or OVA file

3. Click "Next"

4. Put a "Name" and "Select the OVA File"

5. Click "Next"

6. Select Storage and click Next

7. On "Deployment options", Select:
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a) "Network Mappings" → Select "EXTERNAL" and "INTERNAL" interfaces of the CSC.

b) Disk Provisioning: Thin

c) Power on Automatically

8. Click "Next"

9. The next screen will show all values:

10. Click "Finish"
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6.3 Using Hyper-V

Before to start: You will receive the CSC disk (.vhdx) on zip format. Please unzip it and place it on 
your Virtual Machine directory before to start this wizard. 

1. Go to Hyper-V and Click → Action → New

2. Click Next > and Specify Name and Storage

3. Click Next > Select "Generation 1" 
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4. Click Next > Assign Memory: 4096 MB

5. Click Next > Configure Networking 

IMPORTANT: This is the EXTERNAL interface of the CSC. We are going to add the Internal Interface 
later.
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6. Click Next > Connect Virtual Hard Disk  

Select the unzipped disk on "Use an existing virtual disk"

7. Click Next > Summary > Finish . 

The machine will be created but we need to add the INTERNAL Interface.

8. Right Click the machine created > Settings > Add Hardware > Network Adapter

9. Click Add > and connect it to your INTERNAL virtual switch
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10. Click Apply and OK.

6.4 Using KVM
When using KVM, you will receive the disks of the CSC GRE Cluster in qcow2 format. 

The following example shows the installation on a KVM server using Virtual Machine Manager 

(VMM)

1. Go to New -> Create a new Virtual Machine and select "Import existing disk image"
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2. Click "Forward"

3. Browse for the Disk and select Ubuntu 20.04 (or another Ubuntu version if 20.04 is not 

available) 

4. Click Forward.

5. Select 2 x CPU and 4 GB Memory (or more).

Maidenhead Bridge Cloud Security Connector GRE Cluster | 25



6. Click Forward.

7. Put the Name of the CSC, Select "Customise configuration before install" and choose here 

the External Interface.

8. Click Finish. 

9. We need to add now the Hardware for the Internal Interface.  Click "Add Hardware", select 

"Network" and on Network Source choose the Internal Interface of the CSC.

10. Click Finish.
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11. The last step is: "Begin Installation"

12. Done! Repeat the same process for the other CSC. 

6.5 VM sizing
The CSC is a very efficient device and consumes few CPU and RAM resources. By default, we ship it 

with 2 x CPU, 4 x GB RAM and 16 GB disk. If you are going to have an intensive use of Proxy Bypass 

and high Private Access traffic, please increase CPU to 4 and RAM to 8 GB.
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7 Powering up the CSC GRE
1. Power on the Virtual Machines.

2. SSH to the CSC using : ssh cscadmin@< CSC IP(eth1) -a > or <  CSC IP(eth1) -b >. On the CSC 

GRE Cluster  CSC IP(eth1) -a is the fourth internal IP and  CSC IP(eth1) -b is the fifth. 

When prompted, put the following username and password to login on the CSC Console:

Username: cscadmin

Password: maidenheadbridge

Note: SSH to the EXTERNAL interface IPs is not allowed. 
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Select 1) Show Configuration and Status and Check Tunnel Status. 

Congratulations! You are connected to Netskope. 

In the next chapter, we are going to discuss the multiple options to steer traffic to Netskope via the

CSC GRE Cluster. 
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8 Steering traffic to NewEdge with the CSC GRE Cluster. 
In Chapter 3 of this Administrator Guide, we showed the Network Diagrams of different scenarios 

of traffic steering. In this chapter, we are going to dig into more detail about the configuration 

required.

We are going to analyse three scenarios:

1. Using Proxy settings to steer traffic to Netskope: This scenario is for companies currently 

using PAC files (and maybe some client software) and migrating to Netskope Secure Web 

Gateway.

2. Routing all traffic to Netskope: This scenario is for companies who want to send all traffic to 

Netskope to use Cloud Firewall plus Secure Web Gateway.

3. Scenarios 1 and 2 combined: In this case, we will show how to use previous methods 

simultaneously and how the CSC helps to connect any device to Netskope NewEdge.

8.1 Example of Proxied Traffic to Netskope: ON/OFF 
Corporate Network. 

8.1.1 Network diagram

8.1.2 Scenario, Objectives and Solution

Scenario

Before Netskope, the company used a legacy SWG appliance and now wants to migrate to 

Netskope Cloud SWG.
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The default route to the Internet is via the Firewall.

The company devices used a mix of PAC files, Explicit Proxy Settings and software clients to redirect

traffic to the legacy SWG.

When the user was OFF Corporate network, it required the use of VPN to access corporate sites or 

sites are reachable only if using the Public company IP.

Objectives

1. To protect Users when surfing the Internet.

2. To provide users with the same experience when they are ON or OFF Corporate Network.

3. To reach Microsoft O365 Authentication destinations using the company Public IP to apply 

Conditional Access rules and Multifactor Authentication controls.

4. To reach specific sites from the company Public IP. 

Solution

1. Deploy the CSC GRE Cluster in the same place as the Legacy SWG.

2. Create the PAC files to send traffic via the CSC GRE Cluster to Netskope and bypasses via the

company Public IP.

3. Use the Netskope Client to steer traffic when the user is OFF the Corporate network and 

allow remote access to company applications.

8.1.3 Detailed configuration

In the proxy scenario, we will use the CSC VIP Proxy IP and CSC Proxy Bypass IP. 

The flow of the traffic via the CSC will be the following:

CSC internal IP Name: Proxy IP : PORT Purpose

CSC VIP Proxy IP 172.19.0.61:80 Traffic to Netskope

CSC Proxy Bypass IP 172.19.0.62:3128 Traffic to Trusted Sites (Public IP required.)
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8.1.3.1 Sites to Bypass

Sites required to be bypassed from Netskope in this example:

# URL Network / Subnet Purpose

1 login.microsoftonline.com, 
login.microsoft.com, 
login.windows.net

20.190.128.0/18
40.126.0.0/18

O365 login URLs. Bypass required for Conditional 
Access Rules and MFA controls. 

2 portquiz.net 52.47.209.216/32 Trusted site required to be reached via company 
Public IP. 

8.1.3.2 Configuring the Proxy Bypass on the CSC

The recommended method to configure the Proxy Bypass is to create a PAC file and host the PAC 

file somewhere on the internet.

In this example, we are hosting the PAC file on an AWS bucket. Here are the details.

PAC URL https://mhb-netskope-pac-files.s3.eu-west-1.amazonaws.com/mhb-netskope-csc-bypass-pac-
documentation.pac

PAC content function FindProxyForURL(url, host) {

    // The value of bypassproxy here is not relevant. Leave this value as-is. 
    var bypassproxy = "PROXY 172.16.1.1:3128";

    // =========================================================
    // Section 3: bypassproxy via Cloud Security Connectors

    // bypassproxy via CSC Public IPs (Examples)
    // O365 Domains for ConditionalAccess
    if ((shExpMatch(host, "login.microsoftonline.com")) ||
        (shExpMatch(host, "login.microsoft.com")) ||
        (shExpMatch(host, "login.windows.net")) ||
        // IP / Port test page
        (shExpMatch(host, "portquiz.net"))) {
        return bypassproxy
    }
    // =========================================================

    // This return sentence does nothing. It is for script compatibility purposes only. 
    return bypassproxy
}

The next step is to configure the PAC URL on all CSCs and refresh the Proxy Bypass list.
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Later in this Guide, it is explained in more detail the configuration for Proxy Bypass. 

8.1.3.3 PAC file for Company Devices: Laptops, desktops, servers, Etc.

Here the PAC file for company devices: 

PAC URL https://mhb-netskope-pac-files.s3.eu-west-1.amazonaws.com/mhb-netskope-laptop-desktop-pac-
documentation.pac

PAC Content function FindProxyForURL(url, host) {
    // =========================================================
    // Section 1: Standard PAC values

    var privateIP = /^(0|10|127|192\.168|172\.1[6789]|172\.2[0-9]|172\.3[01]|169\.254|192\.88\.99)\.[0-
9.]+$/;
    var resolved_ip = dnsResolve(host);

    /* Don't send non-FQDN or private IP auths to us */
    if (isPlainHostName(host) || isInNet(resolved_ip, "192.0.2.0", "255.255.255.0") || 
privateIP.test(resolved_ip))
        return "DIRECT";

    /* FTP goes directly */
    if (url.substring(0, 4) == "ftp:")
        return "DIRECT";

    // =========================================================
    // Section 2: Define Variables

    var tonetskope = "PROXY 172.19.0.61:80; DIRECT";
    var bypassproxy = "PROXY 172.19.0.62:3128; DIRECT";

    // =========================================================
    // Section 3: bypassproxy via Cloud Security Connectors

    // bypassproxy via CSC Public IPs (Examples)
    // O365 Domains for ConditionalAccess
    if ((shExpMatch(host, "login.microsoftonline.com")) ||
        (shExpMatch(host, "login.microsoft.com")) ||
        (shExpMatch(host, "login.windows.net")) ||
        // IP / Port test page
        (shExpMatch(host, "portquiz.net"))) {
        return bypassproxy
    }

    // =========================================================
    // Section 4: Default Traffic

    // Default Traffic Forwarding.
    return tonetskope
}

Sections of the PAC file for company devices:

Section 1: This section contains common values of a PAC file to send DIRECT traffic to internal 

networks (10/8, 172.16/12, 192.168/16, Etc.), FTP and others. You can leave this section as-is.
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Section 2: In this section, you need to fill in the values of the variables tonetskope (via CSC VIP) and

bypassproxy (via CSC Proxy Bypass IP)

Section 3: Section 3 is a copy/paste of the relevant information of PAC for the CSC and contains the

list of destinations that will be bypassed using the company public IP.

Section 4: Default traffic will go via Netskope.

8.1.3.4 Netskope Client & Netskope Private Access

The last task is to install the Netskope Client and to configure three things:

1. Steering Configuration.

2. Detection ON/OFF Premises.

3. Create a Rule for Private Access to allow to reach the "bypassproxy" IP and Port when the 

user is OFF Corporate network. (OFF Premises)

1. Steering Configuration

Go to Settings -> Security Cloud Platform -> Traffic Steering -> Steering Configuration and setup On-

Prem and Off-Prem as shown below.

2. Detection ON/OFF Premises. 

Go to Settings -> Security Cloud Platform > Netskope Client -> Devices, and click "Client 

Configurations" ( right top corner ) 
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Edit "Default Tenant Config" and enable "On-Premises Detection". In our case we created a DNS 

record A (netskope.maidenheadbridge.com) in our DNS server for this specific purpose. 

This DNS record is only available when the User is On-Premises. 

3. Create the App Definition and Rule for "bypassproxy" IP.

Go to Settings -> Security Cloud Platform > Traffic Steering -> App Definition and Select "Private 

Apps"

and create the "Private App" for "bypassproxy" IP and Port (172.19.0.62 / 3128) in our example.
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Finally, include the Private App on an Allow Rule on Policy Settings. 

Go to Policies -> Real Time Protection -> New Policy -> Private App Access. 

Maidenhead Bridge Cloud Security Connector GRE Cluster | 36



Done! Your Setup is complete!

8.1.3.5 User experience On-Prem and Off-Prem

On-Premises

When the User is On-Premises, the Netskope Client icon will show "Netskope Client disabled - GRE 

detected".  Right Click the icon and click Configuration

When On-Prem, the PAC file will command how to redirect the traffic to Netskope and Bypasses.

Netskope will protect the user via the GRE tunnel.

Off-Premises

When the User is Off-Premises, the Netskope Client icon will show "Netskope enabled".  Right Click

the icon and click Configuration:
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In this case, the user traffic to the Internet is protected using the Netskope client tunnel, and 

Private Access is connected, allowing the bypasses to go via the company public IP. How? Below is 

the explanation. 

1. The user types "portquiz.net" on the Browser.

2. The Browser reads the PAC file and uses Proxy 172.19.0.62:3128 to reach "portquiz.net"

3. Private Access intercepts the communication to "Private App" -> 172.19.0.62:3128 and 

sends the traffic to the Publisher that is on the company behind the CSC.

4. Finally, the flow reaches the CSC Proxy Bypass IP and leaves to the Internet via the 

Corporate Public IP.

8.1.3.6 Final conclusion

With this setup, the user will have the same experience when connected to the Corporate Office or

working from home, thanks to the combination of Maidenhead Bridge Cloud Security Connector 

and Netskope SWG + Private Access. 
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8.2 Example of Routed Traffic to Netskope: ON/OFF 
Corporate Network. 
The previous example demonstrated how to create a seamless user experience when using proxy 

settings on companies devices. In this example, we will reach the same objective but routing the 

traffic the Netskope and not using proxy settings.

8.2.1 Network diagram

8.2.2 Scenario, Objectives and Solution

Scenario

Before Netskope, the company used a legacy SWG appliance and now wants to migrate to 

Netskope Cloud SWG + Cloud Firewall. To achieve this purpose, a CSC GRE Cluster will replace the 

legacy SWG.

The company wants to send all traffic to Netskope. For this reason, the default route to the 

Internet is via the CSC GRE Cluster.

Objectives

5. To protect Users when surfing the Internet.

6. To provide users with the same experience when they are ON or OFF Corporate Network.

7. To reach Microsoft O365 Authentication destinations using the company Public IP to apply 

Conditional Access rules and Multifactor Authentication controls.

8. To reach specific sites from the company Public IP. 

Solution
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1. Deploy the CSC GRE Cluster in the same place as the Legacy SWG.

2. Route all traffic via the CSC GRE Cluster.

3. Create the Routed Bypass Rules on the CSC GRE Cluster to reach sites that requires the 

company Public IP. 

4. Use the Netskope Client to steer traffic when the user is OFF the Corporate network and 

allow remote access to company applications.

8.2.3 Detailed configuration

In the  routing scenario, we will use the CSC Gateway IP only.

The flow of the traffic via the CSC will be the following:

CSC internal IP Name: Proxy IP Purpose

CSC Gateway IP 172.19.0.60 Traffic to Netskope and Routed Bypasses. 

8.2.3.1 Sites to Bypass

Sites required to be bypassed from Netskope in this example:

# URL Network / Subnet Purpose

1 login.microsoftonline.com, 
login.microsoft.com, 
login.windows.net

20.190.128.0/18
40.126.0.0/18

O365 login URLs. Bypass required for Conditional 
Access Rules and MFA controls. 

2 portquiz.net 52.47.209.216/32 Trusted site required to be reached via company 
Public IP. 

8.2.3.2 Configuring the Routed Bypass Rules on the CSC
The recommended method to configure Routed Bypass Rules is to create a JSON file and host the 

JSON file somewhere on the internet or internally on company servers. 

In this example, we are hosting the JSON file on an AWS bucket. Here are the details.
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JSON URL https://mhb-netskope-pac-files.s3.eu-west-1.amazonaws.com/routedBypassRulesFile-
documentation.json

JSON content {
  "routedBypassRules": [
    {
      "description": "O365 Login URLs 1",
      "ipProtocol": "tcp",
      "sourceCirdIp": "0.0.0.0/0",
      "destinationCirdIp": "20.190.128.0/18",
      "fromPort": "80",
      "toPort": "80"
    },
    {
      "description": "O365 Login URLs 2",
      "ipProtocol": "tcp",
      "sourceCirdIp": "0.0.0.0/0",
      "destinationCirdIp": "20.190.128.0/18",
      "fromPort": "443",
      "toPort": "443"
    },
    {
      "description": "O365 Login URLs 3",
      "ipProtocol": "tcp",
      "sourceCirdIp": "0.0.0.0/0",
      "destinationCirdIp": "40.126.0.0/18",
      "fromPort": "80",
      "toPort": "80"
    },
    {
      "description": "O365 Login URLs 4",
      "ipProtocol": "tcp",
      "sourceCirdIp": "0.0.0.0/0",
      "destinationCirdIp": "40.126.0.0/18",
      "fromPort": "443",
      "toPort": "443"
    },
    {
      "description": "portquiz.net",
      "ipProtocol": "tcp",
      "sourceCirdIp": "0.0.0.0/0",
      "destinationCirdIp": "52.47.209.216/32",
      "fromPort": "80",
      "toPort": "80"
    }
  ]
}

The Routed Bypass functionality allows you to create rules per Source and Destination Network, 

Protocol (UDP, TCP, ICMP) and Port range. 

In this particular case, the rules are:
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Rule description Purpose

O365 Login URLs 1 and O365 Login URLs 2 Routed Bypass to Destination 20.190.128.0/18 port 80 and 433.

O365 Login URLs 3 and O365 Login URLs 4 Routed Bypass to Destination 40.126.0.0/18 port 80 and 433.

portquiz.net Routed Bypass to Destination 52.47.209.216/32 port 80

8.2.3.3 Netskope Client & Netskope Private Access

The last task is to install the Netskope Client and to configure three things:

1. Steering Configuration. (same than the previous example)

2. Detection ON/OFF Premises. (same than the previous example)

3. Create a Rules for Private Access. In this case, we need to create Rules for all destinations 

(9) we want to reach via the company Public IP: O365 Login URLs and "portquiz.net". 

After the creation of the Private App, you need to include them on Policies. (Go to Policies -> Real 

Time Protection -> New Policy -> Private App Access. )

Here an example :

9 The amount of Private Access Apss to configure is the main difference between the Proxied and Routed solution. 
In the Proxied solution, it is required to create only one Private Access App: for the CSC Bypass IP. In the Routed 
solution, it is needed to create a Private Access App for each bypass destination.
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8.2.3.4 User experience On-Prem and Off-Prem

On-Premises

When the User is On-Premises, the Netskope Client icon will show "Netskope Client disabled - GRE 

detected".  Right Click the icon and click Configuration

When On-Prem, the Netskope client is disabled, the internal LAN network routes all traffic to the 

Internet to the Cloud Security Connector. The CSC will route the bypass traffic to the Firewall, and 

everything else will travel via the GRE tunnel to Netskope NewEdge. In this case, Netskope 

NewEdge provides Cloud Security Web Gateway and Cloud Firewall protection. 
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Off-Premises

When the User is Off-Premises, the Netskope Client icon will show "Netskope enabled".  Right Click

the icon and click Configuration:

In this case, the user traffic to the Internet is protected using the Netskope client tunnel, and 

Private Access is connected, allowing the bypasses to go via the company public IP. How? Below is 

the explanation. 

1. The user types "portquiz.net" on the Browser.

2. The Browser does a DNS query and resolves "portquiz.net" to obtain the destination IP: 

52.47.209.216.

3. The Browser initiates the communication to  52.47.209.216 

4. Private Access intercepts the communication to "Private App" -> 52.47.209.216 (port 80) 

and sends the traffic to the Publisher that is on the company behind the CSC.
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5. The "default route" sends the flow to the CSC. The CSC checks the destination IP and Port 

(52.47.209.216, port 80) and finds it on the "Routed Bypass List". Finally, the flow  leaves to 

the Internet via the Corporate Public IP.

8.2.3.5 Final conclusion

With this setup, the user will have the same experience when connected to the Corporate Office or

working from home, thanks to the combination of Maidenhead Bridge Cloud Security Connector 

and Netskope. 
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8.3 Putting all together: Proxied and Routed Environments.
The Cloud Security Connector covers all possible scenarios, and this is the main benefit. The Cloud 

Security Connector will protect all company devices with maximum redundancy and High 

Availability.  Below is a list of real cases of devices to connect in large organizations.

This table shows some examples of devices and the steering traffic options for each one. 

# Device Steering traffic options (10)

1 Laptops Netskope Client (NC), PAC files , Routing.

2 Desktops Netskope Client (NC), PAC files , Routing, Explicit Proxy. 

3 Servers PAC Files, Routing, Explicit Proxy.

4 Servers with no default route to Internet. PAC files, Explicit Proxy.

5 Companies with No Default Route to 
Internet. All devices.

PAC files, Explicit Proxy. 

6 IOT Devices. Routing, Explicit Proxy.

7 Linux Servers. Routing, Explicit Proxy.

8 Cameras, Room Reservations Systems, 
Alarms Systems, etc. 

Routing, Explicit Proxy.

10 In most cases, you can combine the options shown. 
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8.4 Testing traffic to Netskope

8.4.1 www.notskope.com

The page www.notskope.com shows the Netskope Datacenter and the GRE IP of the CSC. 

Using the browser:

Using curl command from CMD or  Terminal

Proxy environment: 

Command curl --proxy http://<CSC VIP>:80 www.notskope.com
(i.e. $curl --proxy http://172.19.0.61:80 www.notskope.com)

Expected Result <NewEdge Node IP> <City>,<Country> (<NodeID>)
(i.e. 163.116.162.117 London, United Kingdom (LON1) )
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Routed environment:

Command curl www.notskope.com
(i.e. $curl www.notskope.com)

Expected Result <NewEdge Node IP> <City>,<Country> (<NodeID>)
(i.e. 163.116.162.117 London, United Kingdom (LON1) )

8.4.2 https://ip.maidenheadbridge.com

Maidenhead Bridge provides a HTTPS page to check the IP. 

Using the Browser:

Using curl command from CMD or  Terminal

(Note: the switch "-k" on curl command is to avoid SSL certificate validation)

Proxy environment: 

Command curl -k --proxy http://<CSC VIP>:80 https://ip.maidenheadbridge.com
(i.e. $curl --proxy http://172.19.0.61:80 https://ip.maidenheadbridge.com)

Expected Result <Customer IP>, <Netskope Node IP>
(i.e. 82.68.6.74, 163.116.162.117)

Routed environment:

Command curl -k https://ip.maidenheadbridge.com
(i.e. $curl -k https://ip.maidenheadbridge.com)

Expected Result <Customer IP>, <Netskope Node IP>
(i.e. 82.68.6.74, 163.116.162.117)
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8.4.3 SpeedTest

The CSC contains the SpeedTest client. You can run it from the SSH console or using any 

Management tool (AWS Systems Manager, Rundeck, Salt, Ansible, etc.) 
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9 SSH Admin Console
The SSH Admin Console simplifies admin tasks showing what is essential to administrators for 

configuration, operation and troubleshooting.

Access to SSH Admin Console:  $ssh cscadmin@<CSC GW IP>

User: cscadmin  / Default Password: maidenheadbridge / IP to SSH <CSC GW IP>

Main Menu:
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9.1 Monitoring Tasks

9.1.1 Show Configuration and Status

Show Configuration and Status. This menu show all parameters configured on the CSC GRE and 

does several checks.
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9.1.1.1 General Information

9.1.1.2 Interfaces Information

9.1.1.3 TRAFFIC REDIRECTION Options

9.1.1.4 DNS INFORMATION

9.1.1.5 NETSKOPE INFORMATION

Maidenhead Bridge Cloud Security Connector GRE Cluster | 52



9.1.1.6 TUNNEL STATUS

9.1.1.7 HTTP://WWW.NOTSKOPE.COM PAGE STATUS

9.1.1.8 PROXY BYPASS - EGRESS INTERFACE STATUS

9.1.1.9 ROUTED BYPASS

9.1.1.10 AWS SSM AGENT

9.1.1.11 SYSLOG INFORMATION
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9.1.1.12 HIGH AVAILABILITY Information

9.1.2 Show Interfaces Traffic

9.1.3 Traceroute and Latency Test

This test does a MyTraceRoute test to Primary and Secondary Node and a reverse traceroute from 

the active tunnel to the local IP.  This test helps administrators to validate the quality of the 

Internet path, hop by hop. 
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9.1.4 Speed Test

9.2 CSC Admin Tasks

9.2.1 AWS SSM Agent (Register / De-Register)

The CSC GRE can be integrated as "Managed Instance" with Amazon Cloud (AWS).  

Amazon AWS offers on the Free Tier Account (https://aws.amazon.com/free)  the capability to add 

up to 1000 managed instances. 

The steps required to add the CSC to AWS are two:

1. Create the Keys to register using "Hybrid Activation". 

2. Register the CSC with the Keys

9.2.1.1 Create the Key using "Hybrid Activations"

1. Open your AWS console and go to: "AWS Systems Manager"
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2. Click "Hybrid Activations". We recommend to put the name to identify the CSC on 

"Activation Description" and "Default Instance Name". In this example is cgs00045
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3. Click "Create activation" to generate the Keys. Please, also note the AWS Region

9.2.1.2 Register the CSC on AWS

Using the Keys and Region from the Step before, register the CSC.  

1. From the CSC Admin Tasks Menu, select "5) AWS SSM Agent (Register or De-Register)"

2. Register using the Keys and region:

Done! You have the CSC integrated with AWS now with the instance-id "mi-xxxxxxxxx" ("mi-

0c10191c04e30c0ef" in this example). 
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Go to AWS System Manager →  Managed Instances you will be able to see your CSC.

9.2.1.3 Checking the status of the AWS SSM agent

The "Show Configuration and Status" Menu shows the status of the AWS SSM agent at the bottom.

IMPORTANT: Go to Appendix B to learn how to "Run Commands" from the AWS console to 
monitoring the CSC and Update Bypass Lists. 

9.2.2 Manage Administrators

This section allows to setup specific settings for user "cscadmin" (console user) and "csccli" (cli 

user).
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9.2.2.1 cscadmin settings

9.2.2.2 csccli user

Note: the "csccli" user allows console access to the CSC. If you are managing the CSC using 
Rundeck, Salt or Ansible, you will need to enabled the "csccli" user and to setup the SSH Key.  

9.2.3 Change Timezone

You can change the TimeZone of the CSC using this menu. 
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9.3 Proxy Bypass
The Proxy Bypass functionality allows doing layer 7 bypasses. This functionality works in 

conjunction with PAC files.

9.3.1 Proxy Bypass - Traffic Flow

9.3.2 View Current Proxy Bypass List

This menu displays the current Proxy Bypass List. For example:

9.3.3 Configure Proxy Bypass List

This menu allows to configure the Proxy Bypass List.
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9.3.3.1 Auto - Proxy Bypass PAC URL

Auto–Proxy Bypass PAC URL is the recommended method to use. You need to create a "Proxy 

Bypass PAC file" and host the PAC file somewhere on the internet. The CSC will read the "Proxy 

Bypass List" from the "Proxy Bypass PAC file".

The "Proxy Bypass PAC file" acts as a central repository of all Layer 7 bypasses required. Moreover, 

if you manage the CSCs using AWS Systems Manager (or another tool), you can update all CSCs in 

your network doing one command.

In Chapter 8.1) "Example of Proxied Traffic to Netskope: ON/OFF Corporate Network. " we 

explained how to use the Proxy Bypass functionality. In this chapter, we are going to see how to 

configure and refresh the list. 

Example of Proxy Bypass PAC:

Note 1: It is mandatory to use this function and format. Feel free to add lines but don’t change the format. We 
recommend to start filling the first line and the last line. Use middle lines for copy/paste. 

Note 2: The Bypass Proxy port is 3128
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Configuring the Proxy Bypass PAC URL and Refresh the List

9.3.3.2 Manual

If you want to update manually your Proxy Bypass list, follow this steps.

1. Select Option 2)

2. Input "y"
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3. Add / Delete / Modify your full domains and subdomains

4. Please, CTL+X and "Yes" (and after next prompt Enter) to Save

5. The modified Bypass List will be displayed. 

6. Apply Changes Yes or No. If "1" you will receive the following message:
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9.4 Routed Bypass
When routing all traffic via the CSC GW IP, the Routed Bypass functionality allows you to connect 

specific destinations (IP/Subnet) direct to the Internet, using your Public IP. By default, all 

destinations will travel via the GRE tunnel to Netskope. If you want to bypass the GRE tunnel, you 

need to create a Routed Bypass Rule.

9.4.1 Routed Bypass - Traffic Flow

9.4.2 View Current Routed Bypass List

You can select to view the Routed Bypass Rules in Compact format or JSON. 

9.4.2.1 Compact
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9.4.2.2 Json

Maidenhead Bridge Cloud Security Connector GRE Cluster | 65



9.4.3 Configure Routed Bypass List

There are two methods to configure the Routed Bypass List: Routed Bypass URL and Manual. The 

recommended method is to use Routed Bypass URL. 

9.4.3.1 Routed Bypass URL

Routed Bypass URL is the recommended method. Create an AWS bucket and place your JSON file 

on it. Here an example:  

https://mhb-netskope-pac-files.s3.eu-west-1.amazonaws.com/routedBypassRulesFile-

documentation.json 
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9.4.3.2 Manual (Paste Routed Bypass JSON file)

Another option to configure Routed Bypass Rules is to paste the JSON file using the following 

menu:

and paste the JSON file. The JSON file will be displayed, and if no errors are found, you can apply 

the changes:
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9.5 Log Information
This section shows the Logs. You can see the Current Month or Last 6 Months. 

9.5.1 View Current Month

9.5.2 View Last 6 Months
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9.6 Configuration Wizards
In this section, you can run the Configuration Wizard to change GRE Nodes, DNS servers, Etc; 

Switch tunnels and Update Netskope Nodes Database.

9.6.1 Change Nodes, DNS servers, Syslog and more.

With this wizard you can change:

1. Netskope Nodes

2. DNS Servers

3. Bypass Proxy PAC URL

4. Routed Bypass JSON URL

5. Syslog Servers. 
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9.6.1.1 Running the Configuration Wizard

Select Nodes, Auto o Manual.

If you select "Auto" the CSC will select the nearest Netskope Nodes to "GRE Tunnels egress Public 

IP". If you select Manual, you can choose manually the Nodes Primary and Secondary. 

Selecting "Manual"

-> Select your Primary Node. 

-> Select your Secondary Node
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-> Select 'returnToPrimaryTunnel' variable:

Please select 'true' if you want the CSC to return to Primary tunnel (after 10 min of stability) when 

using Secondary tunnel.

Select 'false' if you want to remain using Secondary Tunnel and not to return to Primary.(Secondary

will be nominated as 'new' Primary)

DNS Configuration

Proxy Bypass Configuration
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Routed Bypass Configuration

Syslog / SIEM Configuration

At the end of the Wizard, you will be asked to confirm this values. 

Done!
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9.6.2 Switch Tunnels - Primary / Secondary.

This Wizard allows to Switch Tunnels Primary to Secondary and vice-versa. 

9.6.3 Update Netskope Nodes Databases.

This command retrieves the latest Netskope Node Database.
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10 Private Cloud Private Access

10.1 What is Private Cloud Private Access (PriCPA)?
Private Cloud Private Access (PriCPA) is a new functionality of the Cloud Security Connector. PriCPA 

allows you to create a Private Cloud among all CSCs for private traffic. In a matter of minutes, you 

can build a full mesh encrypted topology between your locations for private traffic with Zero Trust. 

After making the Private Cloud, you can set up your policies to define who will talk with who inside

your Private Cloud. 

10.2 PriCPA Network Diagrams

10.2.1 High Level Network Diagram
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10.2.2 Low Level Network Diagram – PriCPA only

The following network diagram shows the IP addressing for PriCPA.

Steps to design your Private Cloud:

1. Select a Subnet for your Private Cloud. The example above is 192.168.7.0/24. Due to the 

Subnet is /24, up to 255 CSCs can participate in this Private Cloud.

2. Assign a Cloud Private IP to each CSC. In this example, we are assigning 192.168.7.1 to 

192.168.7.4

3. The Public IP to be used will be the same assigned to the Bypass of each CSC. You can 

choose the UDP port to use at each location. For simplicity, it is recommended to use the 

same port at all locations. 

4. Gather the information of the private Subnets behind each CSC. This information will be 

required when configuring the Peers.

5. Firewall Rules (or Security Groups Rules): The CSC for Azure, AWS and Gcloud will 

implement the firewall rules automatically. Manual FW rules are required when the CSC is 

"On-Premises". The CSC provides a JSON file with the rules required. 
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10.3 Configuring PriCPA
The Main Menu has a section for Private Access:

The configuration of PriCPA is thee simple steps:

1. Create the Local Node configuration. This step will initialize and enable Private Access on 

the Node. The result of this operation will show a "Token" and "Private Access Local JSON 

file". 

2. Initialize the second node in the cluster using the "Token" and "Private Access Local JSON 

file". 

3. Create and distribute the Private Access Peers JSON file to all nodes. 

IMPORTANT: We strongly recommend using software with a JSON formatter to create the Peers 
JSON file, like Visual Code or Notepad ++ . See Appendix C for more detail about how to install 
these programs and the plugins required.

10.3.1 Create the Local configuration (first node of the cluster)

➢ From Main Menu, select "18) Configure Private Access."

➢ Select "1) Create (or change) Private Access Local Configuration"
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➢ Select "1) Manual Configuration" and input the values requested. 

➢ Apply values
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IMPORTANT: The "Token" and "Private Access Local Config JSON file" will be used to create the 
local configuration on the second node of the CSC GRE Cluster. Please, keep these values in a safe 
place. You can use these values to reconfigure any node of the CSC GRE Cluster if necessary in the
future. For example, if you want to change the IPs or descriptions.

10.3.2 Create the Local configuration (second node of the cluster)

SSH the second node if the Cluster and input the "Token"  and "Private Access Local Config JSON 

file".
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10.3.3 Create the Private Access Peers JSON file

The Private Access Peers JSON file contains:

1. The Local configuration of each Peer.

2. The "networks" behind each Peer.

3. The "privateApps" allowed to be reached on each Peer.

Here some examples. 

10.3.3.1 Full mesh Private Access Peers JSON file

 Consider the following example: 
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We have 3 nodes and we want to allow full communication between sites for all port and 

protocols. 

The Local Config JSON file of each node is:

ns-cgc00001

{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "networks": [],
            "privateApps": []
        }
    ]
}

 
ns-cgc00002

{
    "peers": [
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "networks": [],
            "privateApps": []
        }
    ]
}

ns-cgc00003

{
    "peers": [
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "networks": [],
            "privateApps": []
        }
    ]
}
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Firstly, we need to create our "basic" Peers Configuration JSON file: It contains the Local 
Configuration of each Node plus the "networks" behind each node. 

Basic Peers Configuration JSON file

{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.1.1.0/24",
                "10.1.2.0/24"
            ],
            "privateApps": []
        },
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.2.1.0/24",
                "10.2.2.0/24"
            ],
            "privateApps": []
        },
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.3.1.0/24",
                "10.3.2.0/24"
            ],
            "privateApps": []
        }
    ]
}
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In this "Basic Peers Configuration JSON file" we have:

• Green: The Local values generated at each node.
• Yellow: The Subnets behind each node
• Red: Nothing. No private Apps configured. 

If you deployed this "Basic Peers Configuration JSON file" to all CSCs, you have created the Private 
Cloud. All Peers will be visible to each other, but no traffic between subnets will be allowed 
because there is no "privateApps" configured.

If we want to allowed traffic any to any between subnets, we need to add the corresponding 
"privateApps" to each node. For example for node:  "ns-cgc00001"

ns-cgc00001

{
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.1.1.0/24",
                "10.1.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.1.1.0/24",
                        "10.1.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        },

In this case, we added a "privateApp" that allows any source IPs (0.0.0.0/0) to reach the 
"networks" (10.1.1.0/24 and 10.1.2.0/24) using "all" protocols ("ipProtocol" : "all".)
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Now, completing our "Peers Configuration JSON file":

Full Mesh Peers Configuration JSON file. 
{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.1.1.0/24",
                "10.1.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.1.1.0/24",
                        "10.1.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.2.1.0/24",
                "10.2.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.2.1.0/24",
                        "10.2.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "networks": [
                "10.3.1.0/24",
                "10.3.2.0/24"
            ],
            "privateApps": [
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                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.3.1.0/24",
                        "10.3.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        }
    ]
}

Done! Your task is to implement this JSON file on all CSCs and you will have full connectivity any to 
any for all protocols.

10.3.3.2 Understanding "privateApps" configuration and values

Question 1: Where to configure the "privateApps"?

Only on the node that has the "destinationCirdIp": [], that belongs to its "networks". 

Example: I want to allow access to "destinationCirdIp": ["10.1.1.50/32"]. The rule must be created 

on node ns-cgc00001 that has "networks": ["10.1.1.0/24","10.1.2.0/24"]

Question 2 : What about the values to configure?

On "privateApps" section there are two types of values to input:

Accepts single value only -> ""

Accepts single or multiple values -> []

"privateApps": [
                {
                    "description": "",
                    "ipProtocol": "",
                    "sourceCirdIp": [],
                    "destinationCirdIp": [],
                    "destinationSinglePorts": [],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
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Examples:

Single value (""):

"description": " Intranet Servers",
"ipProtocol": "tcp",

Single or Multiple values ([]): 

"sourceCirdIp": ["0.0.0.0/0"],
"destinationCirdIp": ["10.1.1.100/32", "10.1.2.100/32"],
"destinationSinglePorts": [ "80", "443" ],

The following table shows all field and values accepted

Field Value Type Values to configure Example

"description": "", Single String "description": "Intranet Server Access",

"ipProtocol": "", Single tcp,udp,icmp or all "ipProtocol": "tcp",

"sourceCirdIp": [], Single or 
Multiple

Networks in the 
range of: 
10.0.0.0/8
172.16.0.0/12
192.168.0.0/16
and
0.0.0.0/0

"sourceCirdIp": [
    "10.2.1.0/24",
    "10.2.2.0/24",
    "10.3.1.0/24",
     "10.3.2.0/24"
  ],

"destinationCirdIp": [], Single or 
Multiple

Networks in the 
range of 11: 
10.0.0.0/8
172.16.0.0/12
192.168.0.0/16

"destinationCirdIp": [
    "10.1.1.100/32",
    "10.1.1.200/32"
  ],

"destinationSinglePorts": [], Single or 
Multiple

Single Port of the 
range 1 to 65535

 "destinationSinglePorts": [
    "80",
    "443"
 ],

"destinationPortRange": {
    "fromPort": "",
    "toPort": ""
}

Single Single Port of the 
range 1 to 65535

"destinationPortRange": {
    "fromPort": "3780",
     "toPort": "3784"
}

11 The expected value here is a value that belongs to the "network" defined behind the CSC. For example, of the 
network behind the CSC is 10.1.1.0/24, any destination configured must belong to 10.1.1.0/24, like 10.1.1.100/32. 
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10.3.3.3 Example of "privateApps" for a Windows Domain controller

The following example shows how to create rules to allow access to your Domains Controllers.  

The port information was taken from this article: 

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-

domains-and-trusts

Example: Domain Controllers IPs: "10.2.1.100/32" and "10.2.2.100/32" on Node ns-cgc00002 of previous example

"privateApps": [
                {
                    "description": "Domain Controllers TCP",
                    "ipProtocol": "tcp",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.100/32", "10.2.2.100/32" ],
                    "destinationSinglePorts": [ "135", "464", "389", "636", "3268", "3269", "53", "88", "445" ],
                    "destinationPortRange": { "fromPort": "49152", "toPort": "65535" }
                },
                {
                    "description": "Domain Controllers UDP",
                    "ipProtocol": "udp",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.100/32", "10.2.2.100/32" ],
                    "destinationSinglePorts": [ "123", "464", "389", "53", "88" ],
                    "destinationPortRange": { "fromPort": "", "toPort": "" }
                },
                {
                    "description": "Domain Controllers Ping",
                    "ipProtocol": "icmp",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.100/32", "10.2.2.100/32" ],
                    "destinationSinglePorts": [],
                    "destinationPortRange": { "fromPort": "", "toPort": "" }
                }
            ]

10.3.3.4 Example of "privateApps" for Internal Web Server.

In this example, we are showing how to configure access to users on ns-cgc00001  to an Internal 

Web server located behind node Node ns-cgc00003.

Example: Web Server "10.3.1.200/32" on Node ns-cgc00003 of previous example. Allow access to all users behind ns-cgc00001 

"privateApps": [
                {
                    "description": "Web Server 3",
                    "ipProtocol": "tcp",
                    "sourceCirdIp": [ "10.1.1.0/24", "10.1.2.0/24" ],
                    "destinationCirdIp": [ "10.3.1.200/32" ],
                    "destinationSinglePorts": [ "80", "443" ],
                    "destinationPortRange": { "fromPort": "", "toPort": "" }
                }
            ]
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10.3.4 Load the "Private Access Peers JSON file" to the CSCs.

After the Local Configuration is done and the "Private Access Peers JSON file" is created, the next 

task is to distribute and apply it on each CSC.

There are three methods available:

1. URL: (Recommended) Using "Private Access Peers URL" and running the command "Refresh

Private Access Peers URL" using AWS Systems Manager or Rundeck.

2. DevOps: Distribute the JSON file on all CSC and run the command "Reload Private Access 

Peers URL" using AWS Systems Manager or Rundeck.

3. Manual: Copy/Paste the JSON file on each CSCs. 

In this section we are going to explain two methods: URL and Manual Copy. The DevOps method is 

explained on Section12: DevOps operations.

10.3.4.1 Using "Private Access Peers URL"

This is the recommended method. The steps to configure are:

1. Place the Private Access Peers JSON file on an internal web server or an AWS bucket12 or 

similar.  Obtain the download URL. 

Example of AWS bucket:

2. Configure the URL on each CSC.

Ssh the each CSC and go to Main Menu -> 18) Configure Private Access 

12 See Appendix D to learn how to secure an AWS S3 bucket by Source IP. 
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At this moment, you have the option to review the privateApps to configure in Compact or JSON 

format and to apply the values. 
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3. The next time you want to refresh the Private Access Peers JSON file, update the file, 

deploy it on the same location URL and Run Command: "Refresh Private Access Peers URL" 

using AWS SSM Agent or Rundeck. 

AWS System Manager:

➢ Go to AWS Systems Manager -> Run Command -> and Select "MHB-CSC-Refresh-Private-

Access-Peers-URL"

➢ Move down the screen and select all CSCs:

➢ Go to the bottom of the page and click "Run". The next page shows the status of the 

command on each CSC.
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➢ To see the individual result, right click on the Instance ID and open it on a new TAB. Check 

the "Output"
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Using Rundeck

➢ Go to the Project <name> -> All Jobs -> Run " Refresh Private Access Peers URL"

➢  Select ALL nodes and click Run.

➢ Wait to succeeded. You can click on "command" to see the results node by node. 
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10.3.4.2 Manual: Copy and Paste "Private Access Peers Json file"

From Main Menu, go to 18) Configure Private Access, follow the steps below and Paste the Private 
Access Peers Json File:

Done!
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10.4 Show Configurations and Status Private Access.

10.4.1 Via SSH console

From Main Menu, go to 17) Show Configurations and Status Private Access.

10.4.1.1 Show Peer/s Status

In this menu you can see "All Peers Status" or by peer "Select Peer". 

1. Show All Peers Status

IMPORTANT: This section show is the Peer is Alive and the "Source Port" that arrives at this node 
from the Peer. The Source Port information is essential to validate that the NAT on the Remote 
Peer is correct or if the FW on the other end is changing the Source Port. Please, correct the NAT 
on the remote Peer if you see that the Source Port differs from the expected.
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2. Select Peer

This section shows a more detailed information about the Peer.

10.4.1.2 Show Peers Json file (active)

This menu shows the active Private Access Peers Json file.
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10.4.1.3 Show Local Configuration

This menu shows the Local configuration of the node. 

10.4.1.4 Show Firewall Local Rules

This menu shows in JSON format the Rules required on your local FW for this node.
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10.4.2 Via AWS Systems Manager or Rundeck

In this case, the information provided is only "Show ALL Peer Status"

10.4.2.1 AWS Systems Manager

Go to AWS Systems Manager and Run Command: "MHB-CSC-Show-Private-Access-ALL-Peers-

Status" and select the Nodes. The result will show:

10.4.2.2 Rundeck

On Rundeck, run Job: "Show Private Access ALL Peers Status". Select the nodes. The output will 

show:
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10.5 Configure CSC Remote Management via Private Access.
When the CSC is in HA, like the CSC GRE Cluster, only the active node belongs to the Private Cloud. 

The Standby is not. For this reason, if you want to reach the Standby node using SSH, you must 

configure Remote Management on both CSC of the Cluster (or HA pair).

The configuration is via SSH Main Menu. You need to add the "Management Networks". For 

example, in your primary Datacentre, you have the Subnet 172.25.0.0/24, and from that Subnet, 

you want to reach ALL CSCs on the Private Cloud.

The configuration will be:
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11 Remote Management using AWS and Rundeck
You can use several tools to Remote Manage the CSC. In this chapter, we are showing how to use 

AWS Systems Manager (Fleet Manager) and Rundeck. 

11.1 AWS Systems Manager
The easiest and cheapest way to manage the Cloud Security Connectors is to use AWS Systems 

Manager. AWS official documentation is available here: https://aws.amazon.com/systems-

manager/.

With AWS Systems Manager, you can manage the CSC remotely. To do it, you need to create 

"Documents" in advance. "Documents" are a series of commands used by the "Run Command" 

functionality.

This section explains how to create the "Documents" and how to "Run Commands".

11.1.1 Create Documents

We provide a CloudFormation template to create all "Documents" in one shot. 

Steps:

1. Download the CloudFormation template from: 

https://mhb-netskope-cloudformation.s3.eu-west-1.amazonaws.com/MHB-Netskope-CSC-AWS-

Systems-Manager-Documents-v-1-1.json

2. Deploy Stack. Go to Cloudformation →Create Stack

3. Insert the Amazon S3 URL and click next. 

4. Put the Stack Name
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5. Click Next -> Next -> Create Stack. 

6. Wait the Stack to complete. 

7. Now go to Services -> Systems Manager -> and click "Documents" and choose "Owned by 

me"

 

8. Done!
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11.1.2 Run Commands

After you have created the Documents, you are ready to Run Commands on the CSC.

You can see the operation results on the "Output" section or store the results on S3 Buckets for 

further inspection.

To "Run Commands", go to AWS Systems Manager → Instances & Nodes → Run Command.

Here is an example of Running: MHB-CSC-ShowConfigurationAndStatus

1. Run a Command

2. Select the Document created (Tip: Select "Owned by me")

3. Scroll down and Select the Instances
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4. Click "Run" . Wait for the Command Status "success" 

5. Right click on Instance ID (mi-xxxx) and open in new tab. Check Output.
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6. Done! (Note: You can copy the output and to display on a text editor for more visibility)
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11.1.3 List of Documents available for "Run Command" 

1. "MHB-CSC-ShowConfigurationAndStatus": Executes "Show Configuration and Status"

2. "MHB-CSC-SpeedTest": Performs speedtest.net on the CSC.

3. "MHB-CSC-TraceRouteAndLatencyTest": Performs MyTraceRoute test against the Primary 

and Secondary ZEN. It also does a Reverse Test from the tunnel active to your Public IP if 

the tunnel is up. 

4. "MHB-CSC-Refresh-Proxy-Bypass-URL": Refresh the Proxy Bypass list using the values of the

Proxy Bypass PAC file stored in the URL configured. 

5. "MHB-CSC-Refresh-Routed-Bypass-URL": Refresh the Routed Bypass list using the values of 

the JSON file stored in the URL configured. 

6. "MHB-CSC-ShowLogCurrentMonth": Shows current month logs. 

7. "MHB-CSC-ShowLogLastSixMonths": Shows last six month logs. 

8. "MHB-CSC-SwitchTunnels": Switch tunnels. 

9. "MHB-CSC-Reload-Config-json": Reloads the values of config.json file.

10. "MHB-CSC-Reload-High-Availability": Reloads the values of highAvailability.json file. (for CSC

on AWS, Azure and Gcloud. Not in use on CSC for Virtual Platforms. 

11. "MHB-CSC-Reload-Routed-Bypass-json": Reloads the values of routedBypassRulesFile.json.

12. "MHB-CSC-Update-Nodes-Database": Updates the Netskope Node Database.

13. "MHB - CSC - Refresh Private Access Peers URL": Refresh the Private Access Peers list using 

the values of the JSON file stored in the URL configured.

14. "MHB - CSC - Reload Private Access Peers JSON file":  Reloads the values of 

privateAccessPeersConfig.json

15. "MHB - CSC - Show Private Access ALL Peers status": Show the Status of all Private Access 

Peers.
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11.2 Rundeck
Rundeck (https://www.rundeck.com/) is an open-source software Job scheduler and Run Book 

Automation system for automating routine processes across development and production 

environments. It combines task scheduling multi-node command execution workflow orchestration

and logs everything that happens.

Installation Steps:

1. Install Rundeck. Intructions at: https://www.rundeck.com/open-source

2. Create a Project.

3. Enable user "csccli" and setup the SSH Public key on each CSC. 

4. On the Project, setup the SSH Private and define the nodes:

5. Create the jobs. Please, contact Support at http://support.maidenheadbridge.com for the 

latest Job List. 

Maidenhead Bridge Cloud Security Connector GRE Cluster | 104



11.2.1 Jobs

The following screen shows the list of Jobs available. 

11.2.2 Running job "Show Configuration and Status"
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12 DevOps operations
The CSC is delivered will all configurations and is ready for production. Even so, during the life cycle

of the CSC, some parametrization may be required to be changed or modified. For this reason, we 

provide some configuration utilities that will help with further parametrization and change 

management.

The CSC offers an option to do some changes using JSON config files. The operation is simple and is

three steps:

1. Obtain the current JSON file from the CSC.

2. Download the modified JSON file to the CSC.

3. "Run Command" (AWS Systems Manager) of the specific "reload" document. (or use 

Rundeck Job)

The JSON files are available are:

1. config.json: Allows administrators to modify specific values on the CSC like GRE Primary, 

Secondary nodes, DNS, Syslog, Routed Bypass URL, Proxy Bypass URL, Etc.

2. routedBypassRulesFile.json: Allows administrators to manually configure Routed Bypass 

Rules if not using the Routed Bypass URL method.

3. privateAccessPeersConfig.json: Use this Json file to configure "networks" and "privateApps"

on your Private Cloud. 

In this chapter, we are going to explain the procedures.
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12.1 config.json file
You can use this file to change DNS, Log Servers, GRE Nodes (Primary/Secondary), etc. 

1. Obtain the current "config.json" from the CSC, running "Run Command" (AWS-

RunShellScript.). For example:

The fields in bold are not configurable. So please, do not modify. 

cat /usr/local/etc/mhb-csc/config.json

{
    "model": "csc-gre-ns-vm",
    "version": "1.1",
    "dns": {
        "primaryDnsIP": "172.19.0.100",
        "secondaryDnsIP": "172.19.0.101"
    },
    "bypassProxyPublicIP": "82.68.6.73",
    "bypassProxyPacUrl": "https://mhb-netskope-pac-files.s3.eu-west-1.amazonaws.com/mhb-netskope-bypass-vm.pac",
    "syslogServers": {
        "primarySyslogIP": "172.19.0.199",
        "secondarySyslogIP": "",
        "syslogTcpPort": 514
    },
    "greCredentials": {
        "autoDiscovery": true,
        "grePublicIP": "82.68.6.74",
        "primaryGreGateway": "163.116.162.36",
        "primaryProbeIpAddress": "10.162.6.209",
        "primaryLocation": "GB,London,LON1",
        "secondaryGreGateway": "163.116.165.36",
        "secondaryProbeIpAddress": "10.165.6.209",
        "secondaryLocation": "GB,Manchester,MAN1"
    },
    "tunnelRedundancy": {
        "returnToPrimaryTunnel": true
    },
    "routedBypassPublicIP": "82.68.6.73",
    "routedBypassJsonFileUrl": "https://mhb-netskope-pac-files.s3.eu-west-1.amazonaws.com/routedBypassRulesFile-documentation.json",
    "privateAccesPublicIpPort": "82.68.6.74:51821",
    "privateAccesPeersJsonFileUrl": "https://mhb-netskope-private.s3.eu-west-1.amazonaws.com/privateAccessPeersConfig-LAB2.json",
    "privateAccessRemoteManagement": [
          "172.19.0.0/24"
    ]
}

2. Create a AWS bucket and place the modified "config.json" file on it. 

3. Download the file to the CSC. Run Command "AWS-RunShellScript" 

wget <Your bucket file URL> -O /usr/local/etc/mhb-csc/config.json

4. Run Document "MHB-CSC-Reload-Config-json" to apply the changes. 
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12.2 routedBypassRulesFile.json
You can use this file to create Routed Bypass Rules manually instead of using the automatic 

method via Routed Bypass URL.

1. Obtain the current "routedBypassRulesFile.json" from the CSC, running "Run Command" 

(AWS-RunShellScript.). For example:

cat /usr/local/etc/mhb-csc/routedBypassRulesFile.json

{
    "routedBypassRules": [
        {
            "description": "O365 Login URLs 1",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "20.190.128.0/18",
            "fromPort": "80",
            "toPort": "80"
        },
        {
            "description": "O365 Login URLs 2",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "20.190.128.0/18",
            "fromPort": "443",
            "toPort": "443"
        },
        {
            "description": "O365 Login URLs 3",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "40.126.0.0/18",
            "fromPort": "80",
            "toPort": "80"
        },
        {
            "description": "portquiz.net",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "52.47.209.216/32",
            "fromPort": "80",
            "toPort": "80"
        },
        {
            "description": "O365 Login URLs 4",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "40.126.0.0/18",
            "fromPort": "443",
            "toPort": "443"
        },
        {
            "description": "Skype and Teams UDP 1",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "13.107.64.0/18",
            "fromPort": "3478",
            "toPort": "3481"
        },
        {
            "description": "Skype and Teams UDP 2",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "52.112.0.0/14",
            "fromPort": "3478",
            "toPort": "3481"
        },
        {
            "description": "Skype and Teams UDP 3",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "52.120.0.0/14",
            "fromPort": "3478",
            "toPort": "3481"
        }
    ]
}
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2. Create a AWS bucket and place on it the modified "routedBypassRulesFile.json" file. 

3. Download the file to the CSC. Run Command "AWS-RunShellScript" 

wget <Your bucket file URL> -O /usr/local/etc/mhb-csc/routedBypassRulesFile.json

4. Run Document "MHB-CSC-Reload-Routed-Bypass-json" to apply the changes. 
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12.3 privateAccessPeersConfig.json
You can use this file to create Private Access Peer Rules manually instead of using the automatic 

method via Private Access Peers URL.

1. Obtain the current "privateAccessPeersConfig.json" from the CSC, running "Run Command"

(AWS-RunShellScript.). For example:

cat /usr/local/etc/mhb-csc/privateAccessPeersConfig.json

{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "networks": ["10.1.1.0/24", "10.1.2.0/24" ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.1.1.0/24", "10.1.2.0/24" ],
                    "destinationSinglePorts": [ "" ],
                    "destinationPortRange": {  "fromPort": "", "toPort": "" }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "networks": [ "10.2.1.0/24",  "10.2.2.0/24" ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.0/24", "10.2.2.0/24" ],
                    "destinationSinglePorts": [ "" ],
                    "destinationPortRange": {  "fromPort": "",  "toPort": "" }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "networks": [ "10.3.1.0/24", "10.3.2.0/24" ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.3.1.0/24", "10.3.2.0/24" ],
                    "destinationSinglePorts": [ "" ],
                    "destinationPortRange": { "fromPort": "",  "toPort": "" }
                }
            ]
        }
    ]
}

2. Create a AWS bucket and place on it the modified "privateAccessPeersConfig.json" file. 
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3. Download the file to the CSC. Run Command "AWS-RunShellScript" 

wget <Your bucket file URL> -O /usr/local/etc/mhb-csc/privateAccessPeersConfig.json

4. Run Document "MHB-CSC-Reload-Private-Access-JSON-file" to apply the changes. 
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13 Appendixes

13.1 Appendix A: Routed Bypass JSON file if you don't have 
Cloud Firewall License.
If you decide to configure the default route to the internet via the CSC and don't have a Cloud 

Firewall license, you need to send only HTTP and HTTPS via the GRE tunnel and the rest of the 

traffic via Routed Bypass.

The following JSON file does the work to redirect only Web traffic via the GRE tunnel, and the rest 

goes directly via the Bypass Interface.

{
    "routedBypassRules": [
        {
            "description": "Bypass ICMP all",
            "ipProtocol": "icmp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "0.0.0.0/0",
            "fromPort": "",
            "toPort": ""
        },
        {
            "description": "Bypass TCP Ports I",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "0.0.0.0/0",
            "fromPort": "1",
            "toPort": "79"
        },
        {
            "description": "Bypass TCP Ports II",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "0.0.0.0/0",
            "fromPort": "81",
            "toPort": "442"
        },
        {
            "description": "Bypass TCP Ports III",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "0.0.0.0/0",
            "fromPort": "444",
            "toPort": "65535"
        },
        {
            "description": "Bypass UDP Ports all",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "0.0.0.0/0",
            "fromPort": "1",
            "toPort": "65535"
        }
    ]
}
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13.2 Appendix B: Release Notes

13.2.1 Version 1.0

This is the initial version of the Cloud Security Connector for Netskope. 

13.2.2 Version 1.1

The version 1.1 contains the following enhancements:

• New! Private Cloud Private Access (PriCPA) functionality. PriCPA allows you to create a 

Private Cloud among all CSCs for private traffic. In a matter of minutes, you can build a full 

mesh between your locations for private traffic with Zero Trust. After making the Private 

Cloud, you can set up your policies to define who will talk with who inside your Private 

Cloud.

• Minor cosmetic changes on some menus.
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13.3 Appendix C: JSON formatters (Visual Code, Notepad ++)
We strongly recommend using Software that can show errors on your JSON file and also can format

(beautify) the file for better visibility. Below two examples.

13.3.1 Visual Code

1. Download : https://code.visualstudio.com/download

2. Select your platform and install. 

3. Create your JSON. 

3.1. Visual Code will show the errors in RED. 

3.2. To "Beautify" your JSON file press:

3.2.1. On Windows: "Shift + Alt + F"

3.2.2. On MAC: "Shift + Option + F"

3.2.3. On Linux: " Ctrl + Shift + I"
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13.3.2 Notepad ++

1. Download: https://notepad-plus-plus.org/downloads/

2. Install JSON Viewer Plug in.

3. Create your JSON file.

4. To Check your JSON file go to: Plugins -> JSON Viewer -> Show JSON Viewer.
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5. To format ("Beautify") your JSON go to: Plugins -> JSON Viewer -> Format JSON
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13.4 Appendix D: Securing an AWS Bucket by source IP.
1. On your AWS console create a bucket with default values for permissions: "Block all Public 

Access = on"

2. On Bucket Policy, add your Public IPs in "aws:SourceIp":[]

{
    "Version": "2012-10-17",
    "Id": "S3PolicyId1",
    "Statement": [
        {
            "Sid": "IPAllow",
            "Effect": "Allow",
            "Principal": "*",
            "Action": "s3:*",
            "Resource": "arn:aws:s3:::mhb-netskope-private/*",
            "Condition": {
                "IpAddress": {
                    "aws:SourceIp": [
                        "200.1.1.1/32",
                        "200.1.1.2/32",
                        "200.2.0.0/24"
                    ]
                }
            }
        }
    ]
}

3. Done! 
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